
© 2024 CS Odessa corp.

www.conceptdraw.com

o   User Interface Reference

o   Keyboard Shortcuts



ConceptDraw PROJECT  User Interface Reference

© 2024 CS Odessa corp.

Welcome to ConceptDraw PROJECT 15  for Windows 1

Toolbar Tour 2

................................................................................................................................... 3Quick Access 

................................................................................................................................... 4File 

.......................................................................................................................................................... 6Print Preview 

.......................................................................................................................................................... 7Import 

.......................................................................................................................................................... 8Export 

................................................................................................................................... 9Home 

.......................................................................................................................................................... 12Microreports 

......................................................................................................................................................... 13Deadline Reminders

.......................................................................................................................................................... 15Project Baseline 

................................................................................................................................... 16View 

.......................................................................................................................................................... 18Gantt Chart 

......................................................................................................................................................... 21Gantt Chart Context Menu

.......................................................................................................................................................... 23Resources 

......................................................................................................................................................... 25Resources Context Menu

.......................................................................................................................................................... 26Multiproject Dashboard 

......................................................................................................................................................... 28Multiproject Context Menu

......................................................................................................................................................... 29Multiproject Settings

.......................................................................................................................................................... 31Resource Usage 

.......................................................................................................................................................... 33Filters Mode 

.......................................................................................................................................................... 35Critical Path 

................................................................................................................................... 36Share 

.......................................................................................................................................................... 37DIAGRAM 

.......................................................................................................................................................... 38MINDMAP 

.......................................................................................................................................................... 40MS Excel 

Dialogs 41

................................................................................................................................... 42Timescale 

................................................................................................................................... 43Column Customization 

................................................................................................................................... 48Edit Markers 

................................................................................................................................... 49Predecessors 

................................................................................................................................... 50Filters 

................................................................................................................................... 53Options 

................................................................................................................................... 55Document Properties 

................................................................................................................................... 63Find 

................................................................................................................................... 64Replace 

Floating Panels 65

................................................................................................................................... 66Task 

................................................................................................................................... 70Project 

................................................................................................................................... 71Resource 

................................................................................................................................... 72Assign Resources 



Contents

© 2024 CS Odessa corp.

................................................................................................................................... 73Solutions 

.......................................................................................................................................................... 75Tabular Reports 

......................................................................................................................................................... 79Custom Repots

.......................................................................................................................................................... 81Mind Map Reports 

.......................................................................................................................................................... 83Visual Reports 

.......................................................................................................................................................... 86Dashboards 

......................................................................................................................................................... 87Project Dashboard

......................................................................................................................................................... 90Radar Chart

......................................................................................................................................................... 91Tactical Dashboard

................................................................................................................................... 93Slide Navigator 

................................................................................................................................... 94Hypernote 

................................................................................................................................... 95Links 

Keyboard Shortcuts and Mouse Actions 96



Welcome to ConceptDraw PROJECT 15  for Windows

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

1

  

Welcome to ConceptDraw PROJECT 15  for Windows

A full-featured project management solution with all the necessary functions right at your fingertips.
Generates an extensive variety of reports on project and task statuses on macOS and Windows
platforms. Centralizes project information through embedded documents and hyperlinks. Unique
Multiproject Dashboard manages multiple projects from a single file. Powerful integration with other
ConceptDraw products makes project management easier than ever before.
Manage Plans, Reports, and Changes
Benefits
ConceptDraw Maintenance Assurance
Technical Support

Manage Plans, Reports, and Changes
ConceptDraw PROJECT makes planning projects and managing change easy because of the project
focused tools that manage every aspect you, the Project Manager encounters. ConceptDraw PROJECT
builds on established project management methodologies while simplifying the process of managing
project data, making effective responses, and working with project teams.
ConceptDraw PROJECT helps you manage all of your project variables from a single view. You can
quickly generate a broad range of One Click Reports for project variables such as resource usage, task
planning by resource, and budgets. Display up-to-data status on dashboards to keep you current as the
variables change.
ConceptDraw PROJECT is the complete solution to manage single or multiple projects and their
associated resources with a very low cost of ownership.

Your Benefits
ConceptDraw PROJECT gives you the tools to evaluate your project planning. Streamlines meetings and
ensures more effective planning and control thanks to live project dashboard illustrations, mind map
reports, and knowledge metrics.

ConceptDraw Maintenance Assurance 
We have developed an innovative maintenance program that makes sure you stay up to date. At the time
of your buy a ConceptDraw product, you are able to purchase ConceptDraw Maintenance Assurance .

Technical Support
We offer unlimited free technical support to our  users. 
To send us a problem report or feature request, submit the ticket form in the Help Desk section on our
Web site.
Replies are normally sent within one business day. We are always happy to answer your questions and
hear your feedback.

https://www.conceptdraw.com/helpdesk/how-to-upgrade-from-previous-versions
https://helpdesk.conceptdraw.com/ticket.php
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Toolbar Tour

The ConceptDraw PROJECT  toolbar  provides quick access to functions that are commonly performed
within the program.

Quick Access
File
Home
View
Share
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Quick Access  

Quick Access

Quick Access menu facilitates access to the most  frequently used functions. It is located at the top of

Toolbar.

New Start a new document

Open Open an existing document

Save Save the current document

Undo Undo the last action

Redo Redo the last undone action

Print Send the document directly to the default printer without making changes

Print
Preview

Preview and make changes to pages before printing
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File  

File

New Create a new document.

Open Open an existing project.

Recent Show recently opened files.

Save Save the current document.

Save As Save a copy of the document.

Import Import the document.

Export Export the document.

Print Preview and print the document.

Send Send a document.

Close Close ConceptDraw PROJECT.

Properties Contains options allowing you to configure the parameters of the particular
document in the  Document Properties dialog.

Options Allows to configure the application settings in the Options dialog. It allows
you to change default application settings that will be applied to all new
documents created in ConceptDraw PROJECT.
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File  

Preview and print the current ConceptDraw PROJECT file
 

Print Send the document  to the default printer as it is.
Use the View tab to setup the printed  document view.

Print Preview Opens Print Preview tab

Print to
Adobe PDF 

Print to Adobe PDF using the current print settings

 
Send the current document

E-mail Send a copy of the document via e-mail as attachment

Open in MINDMAP Open the current  document in ConceptDraw MINDMAP
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File Print Preview

Print Preview

Preview and make changes to pages before printing.

Print

Print the current document

Print to Adobe PDF using the current print settings

Select the printer and set the printer properties

Print View

Select exactly the view  you need to print: Gantt Chart, or Multiproject.

Scaling
Actual - Print the document in zoom 100% of the actual size.
Fit to - Set the number of pages , your document will be printed

Grid 
Set the print options:  Print the outline and Gantt chart , or Gantt chart only

Timescale
The timescale printing radio button allows to print the entire project timescale.
The dates range selection allows to select the time period to print.
"Do not print" radio button allows to print the entire document without timescale
Legend  

Every page - Print the legend at the bottom of each page.
Legend page  - Print the separate legend page.
None - Do not print legend.
Page Setup
Margins - Set the margins for the current document.
Orientation - Switch the pages between portrait and landscape layout.
Size - Choose the page size from the drop-down list.
Preview
Previous page/Next Page - Navigate between pages on page preview.
Fit  page - Zoom the document so that entire document fits  one page.
Close - Close Print preview.



Toolbar Tour

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

7

File Import

Import

Create ConceptDraw PROJECT document from other file types. The Import section provides the access
to ConceptDraw PROJECT import opportunities:
 

MS Excel - Create project in new document from text outline

MS Project File - Creating new document on the basis of information taken from Microsoft
Project * .mpp document

Mindjet MindManager - Creating new document on the basis of information taken from
Mindjet MindManager * .mmap document

Text outline - Creating new document on the basis of information taken from Microsoft Excel
* .xlsx workbook
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File Export

Export

Create other file types from a ConceptDraw PROJECT document. The Export section provides the
access to ConceptDraw PROJECT export opportunities
 

Adobe PDF - Export the document to Adobe PDF

MS Excel - Save project tables from all views as Microsoft Excel workbook ( *.xlsx)

MS Project File - Export the document to Microsoft Project XML

Mindjet MindManager - Save the document in Mindjet MindManager  * .mmap format

Text Outline -  Export the document to the text outline



Toolbar Tour

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

9

Home  

Home

Clipboard

Paste Paste  content from the Clipboard 

Cut Cut  selection and put it into  Clipboard.

Copy Copy the selection and put it into the Clipboard.

Format Text

Font Select font face

Font size Select font size

Grow font Increase  font size

Shrink font Decrease font size

Make upper case Convert selected to upper case

Make lower case Convert selected to lower case

Make title case Convert selected to title case

Make sentence
case

Convert selected to sentence case

Wrap text Makes all content visible within a cell by
displaying it on multiple lines

Solutions

Solutions Activate Solutions panel

Select View

Gantt Chart Switch to Gantt Chart View

Resources Switch to Resource list

Multiproject Switch to Multiproject Dashboard 

Resource usage Switch to Resource usage view
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Home  

Reports Displays the generation window of the last report. If no reports
have been created yet, a window will open for creating the first
report in alphabetical order in the list of available reports, provided
in the Solutions panel.

Microreports

Microreports Generate Microreports

General

Add Add new item to end

Insert Inserts new item into selected position

Add sub item Add sub item to selected item

Delete Delete selection

Add text box Add a text note to selected task or phase. You can use the Text
Box to add work details, supporting information, or other notes to
tasks and phases on a project Gantt chart directly. A Text Box
can contain just a text with no formatting.

Link

Link Link two or more selected items

Unlink Unlink two or more selected items

Edit button Edit predecessors using the Predecessors dialog
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Home  

Move
Indent Indent selected item (Move selected item one position right)

Outdent Outdent selected item (Move selected item one position left)

Up Move selected item one position up

Down Move selected item one position down

Go To

Selected Show  selected task on Gantt Chart

Today Show today's tasks on Gantt Chart view

Markers   

Markers
Mark selected item with color. Using color markers  is an
efficient way to highlight rows on the project timeline and help
you position and arrange the project items.

Edit Markers button Opens the Edit markers dialog

Calendar

Calendar Shows Document Properties dialog, Calendar tab

Baseline

Save Save Baseline settings for selected tasks

Editing

Find Activate Find dialog

Replace Activate Replace dialog

Smart Enter On/Off the Smart Enter Mode.
When the Smart Enter Mode is active a new Task is added  by
the Enter key.
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Home Microreports

Microreports

ConceptDraw PROJECT gives you an opportunity to communicate with your team faster by using micro-
reports.

A micro-report is a small piece of project information associated with specific task, phase, resource or
project, which you can send via e-mail. It’s a great time saver feature for daily communication with your
team, and it allows you to report project statuses quickly and easily. The list of micro-reports for
choosing is available:
· from the context menu of the the task, phase, resource or project;

· from the Micro-reports button  on the Home tab.

List of reports available for various project tables:

Gantt Chart 
Phase
1. Deadline reminder for all projects.
2. Deadline reminder for the current project.
3. Today tasks list.
4. Critical tasks list.
5. Today tasks list with assigned resources
6. Today resources list
Task
1. Deadline reminder for all projects.
2. Deadline reminder for the current project.
3. Task status.

Resources
1. Today tasks list for all resources.
2. Today tasks list.
3. Milestones.
4. Objectives.
5. Projects list.
6. Next tasks.
7. Assigned tasks.
8. Critical tasks.
9. Deadline reminder for the selected resource.

Multiproject Dashboard
1. Deadline reminder for all projects.
2. Today tasks list.
3. Today resources list.
4. Nearest milestones
5. Deadline reminder for the current project.



Toolbar Tour

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

13

Home Microreports

You need to select the desired type of microreport from the drop-down list, and it will be generated as a
ready-to-send e-mail. Microreports of all types, except reports on deadlines, are generated in both text
and mind map form as ConceptDraw MINDMAP  files (CDMZ), attached to the email message.

 

 
 

Deadline Reminders

A deadline is a target date indicating when a project task must be completed. If the deadline expires and
the task is not completed, the deadline becomes overdue. Deadline Reminders are used to inform
employees involved in a project of the task's upcoming and overdue deadlines. Microreports on deadlines
are generated as email messages addressed to employees assigned to tasks that have upcoming or
overdue deadlines.
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Home Microreports

Select a project, task, or resource. You need to choose the needed type of Microreport from the drop-
down list. Ready-to-send e-mails will be generated. A task is included in the Deadline Reminder if all of
the following conditions are met. You can check them on the Task panel.

1. The task has a Deadline parameter checked.

2. Task completion is less than 100%.

3. The Task Finish date is later than the report date.

Ready-to-send deadline reminders can be created automatically every time you run a project file. Simply
check the "Generate deadline Microreports" option in the ConceptDraw PROJECT Options dialog box.
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Home Project Baseline

Project Baseline

ConceptDraw PROJECT provides the possibility  to set a Project baseline. A Project baseline is a
snapshot (copy) of the current main values of the project and tasks (Start, Finish, Cost). It is used for
assessing performance, and improving the estimation accuracy. Save a baseline when the planning of
project is completed and later compare with it the real values at the implementation and after completion
your project. 

To save a Baseline, click the Save Baseline button  on the Home tab. The following message will
appear:

To undo the last action, click the Undo button on the Quick Access Toolbar or Ctrl+Z on the keyboard. .
Baseline in ConceptDraw PROJECT includes three parameters: Baseline Start, Baseline Finish, and
Baseline Cost. To display them on the Gantt chart, use the Column Customization dialog. Also the value
 of Baseline cost can also be found on the Task panel. As the project progresses, the Baseline will help
you measure any changes in the plan and to determine any differences from your original plan and the
actual state of your project. You can highlight baseline using the button on the View tab.
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View  

View

 
Select View

Gantt Chart: Switch to Gantt Chart View.

Resources: Switch to Resource list.

Multiproject: Switch to Multiproject Dashboard.

Resource usage: Switch to Resource usage view.

Timescale

Zoom in

Zoom out

Timeline: Adjust zoom so, that the  entire project timeline  fit  the screen.

Scale: Show the scale choice drop-down list.

The button at the right bottom of the section opens  Timescale dialog (A timescale ruler (or calendar)
measures time for the tasks in your document. )

Expand/collapse

Expand all: Expand all sub items.

Collapse all: Collapse all sub items.

Expand: Expand selected item.

Collapse: Collapse selected item.

Outline level: Show tasks of the certain outline level.
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View  

Filters

Select Filter: 
Select the embedded filter and activate Filters mode.

Apply previously selected filter.

Clear the current filtering.

Invert the current filter.

Show phases: Show/Hide phases.

Show Highlight: Show/Hide Highlight.

Edit Filter button: Open the Filters Dialog.

Themes

Themes: Select the one of the available Gantt chart views

Show/Hide

Critical path: Show/hide the critical path 

Assigned resources: Show/hide the resources assigned to tasks on the Gantt

Show text boxes: Show/hide  text boxes

Baseline: Show/hide the saved project baseline on the Gantt Chart

Columns

Customize columns: Open the Columns customization dialog and select columns to
display in the project outline.

Panels and Windows   

Panels:  Manage Floating panels.
 

Windows: Shows the list of opened windows.
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View Gantt Chart

Gantt Chart

Typically each project has tasks and phases. Every task represents a single unit of work — a single
step in a multi-step project. A group of related project tasks can be joined into phases. The Gantt chart
window consists of two parts: the project outline — a list of the project tasks and phases and its graphic
representation — Gantt chart. The Gantt chart is the default view of the project file when you run

ConceptDraw PROJECT.  Also, it is accessible by the button  on the Home or  View tab. 

1. A task can be added to the document with one of the following methods:

· By pressing Enter

· Using the General section on the Home tab

· Applying the command Insert New Task from the context menu. 

To turn the selected task into a phase, use the Outdent command. To add a task to a phase, use the
Add Subtask command.

All parameters of the project tasks and phases can be specified in the Tasks dialog. Some parameters
can be specified in the context menu and on the Gantt chart.
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View Gantt Chart

Columns  that contain the project outline information  can be managed using the Task Grid Context
Menu.

Sort Ascending - Sort the project outline list by the column selected (A to Z for words, or smallest to
largest for numbers);

Sort Descending - Sort the project outline list by the column selected  (Z to A for words, or largest to
smallest for numbers );

Not Sorting - Cancel sorting;

Hide Column - Hide the selected column;

Column Customization - invoke the Column Customization dialog.

The width of a column can also be changed. For this set the cursor to the right edge of the column (the
cursor should turn a double-sided arrow) and drag it to the needed direction.
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View Gantt Chart

2. The Gantt chart displays task as bars. Bars are arranged in accordance with the timescale, displaying
the task start /end time and its duration.

The timescale can be changed. This can be done in the Timescale dialog, that can be accessed from the
context menu.

Also  can change the task start/end date, its duration and completion . To change start/end dates move
the bar by your mouse. To change the task duration draw by the right edge of the bar, to change the
percentage of completion draw by the left edge. In both cases the cursor should turn a double-sided
arrow. The non-completed part of the task and the completed one are shown in different colors,
depending on the current Theme. To show/hide the resources involved in these tasks, use the Show/Hide
section in the View tab.

Links between dependent tasks are shown with arrows.  The most common link type, finish to start, is
assigned by the following way: first select the tasks to which you want to assign links, and then use one
of the following:

· The Link group in the Home tab

· The context menu of the Gantt chart view

Any link type can be customized using the dialog Predecessors. 

The widths of the text and graphic parts of the diagram can be changed. For this set the cursor on the
dividing line and draw to the needed direction. 

3. The navigation bar at the bottom of the Gantt chart window allows you to quickly navigate between the
multiple projects Gantt windows that your multiproject contains. Use the "Multi Gantt" option to manage
all the projects of a multiproject file from a single window.
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View Gantt Chart

Gantt Chart Context Menu

Access the most frequently used operations at Gantt Chart window via the context menu.

  
Gantt Chart Context Menu

Text Format

Microreports

Change the text format of the project schedule
 
Generate Microreports
 

Copy Copy the selection and put it into the Clipboard.
Paste Paste  content from the Clipboard.
Paste as Options for pasting tasks copied to the clipboard.

Cut Cut  selection and put it into  Clipboard.
Select All Select all tasks.
Insert New Task Inserts new task into selected position.
Add New Subtask Add sub task to selected task.
Delete Delete selection.
Indent Indent selected tasks (Move selected item one

position right).
Outdent Outdent selected tasks (Move selected item one

position left).
Custom Mark Mark the tasks that need to be represented in the

diagram.
Task Link Link two or more selected items.
Create MINDMAP File Generate a mind map (*. cdmz) from selected

tasks.
The file will be opened in ConceptDraw MINDMAP

Add Text Box Add a text box to selected item.
Markers Make the selected items looking like marked with

a highlighter.
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View Gantt Chart

  
Gantt Chart Timescale Context Menu
 

Zoom In Displays timescale in more detail (day instead of weeks, etc.)
Zoom out Displays a more generalized timescale (weeks instead of days,

etc.)
Timescale Calls Timescale dialog that allows to customize timescale

appearance. It gives more possibilities for this than Zoom In and
Zoom Out commands. On the other hand mentioned commands
allows to change calendar scale quicker.

Calendar Opens the Standard Calendar dialog



Toolbar Tour

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

23

View Resources

Resources

By clicking the  button  on the Home or  View tab, you open the Resources window. This window
contains a list of resources with their characteristics. 
To assign resources to a specific task you should open Gantt Chart, select a task  and  then assign
resources to task using the Assign Resources panel. 
The information on the resources can be edited in the Resource panel.

1. Hyperlink. Click the  icon to add a hyperlink to the resource. The icon  means that this resource
is already accompanied by a hyperlink.

2. Resources can be added by pressing Enter, or from the context menu by applying the command Add
Resource.

3. Click the Type field of the Resource row.  Add the resource type using the drop down menu. There are
five types of Resources in ConceptDraw PROJECT: 
Work 
Material 
Cost 
the applicable cost, every time you use the resource.
Equipment resources - Technical equipment used to perform a task. Has a cost per unit and is applied
if the cost of the equipment used does not depend on the time units
Company 
unit and is applied to specify the applicable cost, every time you use the company resource.

4. Click the Cost field of the Resource row.  Add cost value using the drop down menu. Cost of the Work
resources are those with a cost over time. Other types of resources have a fixed cost per unit.

5. Group. You can categorize project resources by groups. To add a group name, just click the field and
type it. The same resource can be engaged to several groups. Use the Resource panel for grouping.
Assigning a resource group to a task means assigning all resources included in this group in an equal
percentage.  Grouping resources allows you to view and report summary information of resources and
assignments. 
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View Resources

6. Columns that contains contact email and the additional resources information.

7. Click the icon  to open the Work resource individual calendar. You can modify the common working
hour schedules individually for each employee.

Columns that contains the resources information can be managed using the Resource List Context
Menu.

Sort Ascending - Sort the resource list by the column selected (A to Z for words, or smallest to largest
for numbers);

Sort Descending - Sort the resource list by the column selected  (Z to A for words, or largest to smallest
for numbers );

Not Sorting - Cancel sorting;

Hide Column - Hide the selected column;

Column Customization - invoke the Column Customization dialog.

The width of a column can also be changed. For this set the cursor to the right edge of the column (the
cursor should turn a double-sided arrow) and drag it to the needed direction. 
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View Resources

Resources Context Menu

Access the most frequently used operations with resources via the context menu.

 
 Resources List Context Menu

Text Format

Microreports

Change the text format of the project schedule
  
Generate Microreports
 

Copy Copy the selection and put it into the Clipboard
Cut Cut  selection and put it into  Clipboard.
Paste Paste  content from the Clipboard
Add Resource Inserts new resource
Delete Resource(s) Delete selected resources
Calendar Opens the Standard Calendar dialog
Markers Set color markers
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View Multiproject Dashboard

Multiproject Dashboard

ConceptDraw PROJECT lets you track multiple projects at the same time. The Multiproject View permits
the managing of multiple projects and a mutual resource pool from a single file. When you’ve got a multi-

project file,  use the  button  on the Home or View tab. It opens the Multiproject window. This window
contains a list of projects with their characteristics.

1. Projects can be added to the document with one of the following methods:
· By pressing Enter
· Using the General section on the Home tab
· Applying the command Insert New Task from the context menu.

2. You can set the visual parameters of the multiple project Gantt chart using the Multiproject Settings
tab.

3. The timescale can be changed. This can be done in the Timescale dialog, that can be accessed from
the context menu.
Also  can change the task start/end date, its duration and completion . To change start/end dates move
the bar by your mouse. To change the task duration you need to switch to Gantt Chart view.
 
4. Project Group treats each project similarly to a phase, so all the properties are aggregated from the
projects you include. Please note that Project Group  only groups projects, so it does not have its own
tasks. You can group projects using the context menu . You can then select a project and use the
Group Projects command from the context menu or create a New Project Group where you can then
move your projects to. 
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View Multiproject Dashboard

Columns  that contains information on the multiple project can be managed using the Project Grid
Context Menu.

Sort Ascending - Sort the project outline list by the column selected (A to Z for words, or smallest to
largest for numbers);

Sort Descending - Sort the project outline list by the column selected  (Z to A for words, or largest to
smallest for numbers );

Not Sorting - Cancel sorting;

Hide Column - Hide the selected column;

Column Customization - invoke the Column Customization dialog.

The width of a column can also be changed. For this set the cursor to the right edge of the column (the
cursor should turn a double-sided arrow) and drag it to the needed direction.



Toolbar Tour

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

28

View Multiproject Dashboard

Multiproject Context Menu

Access the most frequently used operations at Multiproject window via the context menu.

  Multiproject Context Menu
Text Format
Microreports

Change the text format of the project schedule
 Generate Microreports

View Gantt Chart Switch to Gantt Chart View

New Project Add a new project

New Project Group Add new project group

Insert project from file Add a new project from file

Add  Subproject Add sub project to selected project

Group Projects Join selected projects into a Project Group

Ungroup Projects Split the Project Group into separate projects

Create Mind Map Generate a multipage mind map (*. cdmz) from
selected projects. The file will be opened in
ConceptDraw MINDMAP

Delete Project (s) Delete selected project (s)

Project Link Link Link two or more selected projects

Add Text Box Add a text box to selected item

Markers Make the selected items looking like marked
with a highlighter

  Multiproject Timescale Context Menu
Zoom In Displays timescale in more detail (day instead of weeks, etc.)
Zoom out Displays a more generalized timescale (weeks instead of days,

etc.)
Timescale Calls Timescale dialog that allows to customize timescale

appearance. It gives more possibilities for this than Zoom In and
Zoom Out commands. On the other hand mentioned commands
allows to change calendar scale quicker.

Calendar Opens the Standard Calendar dialog
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View Multiproject Dashboard

Multiproject Settings

You can change the visual parameters of the Multiproject View
 

 
Show/hide
Planned
complete

Show/hide the planned complete mark on
the project Gantt chart

Complete
change value

Show/hide the change of the complete value
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View Multiproject Dashboard

Complete
change rate

Show/hide the symbol of the complete
change rate.
Project’s dynamics are shown using colored
symbols:
• yellow arrows indicate a normal
completion level
• green arrows means that a project is
ahead of schedule
• orange square symbol signals that the
project’s completion didn’t change, the
project “sleeps” and we have zero progress.

Tracking 
period

Select tracking period
Set the frequency of complete values
verification

Task
Completion

Show/hide the colored bar representing the
situation with the completeness of the
project’s tasks. You can see the number of
completed
tasks, the ones in the process, and those
that 
have not been started.
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View Resource Usage

Resource Usage

By clicking the  button  on the Home or View tab, you open the Resource Usage window.
Resource Usage diagram consists of two parts: the task list and graphic presentation of the tasks.

It is a kind of a Gantt Chart which shows you all resources with their usage by tasks and money.
1. You can find out which projects resources are used in, what tasks are assigned to them, and finally,
how much it costs.
2. To quickly move to the Resource view just make double-click on a resource name.
3. To move to the Gantt chart view make a double-click on a task name.
4. The graphic part of the diagram displays tasks as bars. Bars are arranged in accordance with the
Timescale, displaying the task start /end time,  duration, and percentage of resource working time
occupied on a task. 
5. If the total resource load currently exceeds 100%, the resource chart bar will show it with a red color.  
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Columns that contains the resources usage information can be managed using the Resource Usage Grid
Context Menu.

Sort Ascending - Sort the resource usage list by the column selected (A to Z for words, or smallest to
largest for numbers);

Sort Descending - Sort the resource usage list by the column selected  (Z to A for words, or largest to
smallest for numbers );

Not Sorting - Cancel sorting;

Hide Column - Hide the selected column;

Column Customization - invoke the Column Customization dialog.

The width of a column can also be changed. For this set the cursor to the right edge of the column (the
cursor should turn a double-sided arrow) and drag it to the needed direction.
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Filters Mode

The embedded filters of ConceptDraw PROJECT can be very useful for viewing a specific range of
information. You can apply filters to tasks, resources and even projects. Filters mode can be activated 
from the Filters section on the View tab.
 
1. Select one of the embedded filters from the drop-down menu.
 

 
2. Toggle Show/Highlight item,  to highlight filtered items without hiding the other data.
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View Filters Mode

 

3. Toggle Show Phases item to display phases that are associated with tasks which are shown in the
filtered view.
 

4. You can reverse filtering condition using Invert button.
 

 

5. Use the Refilter button  to reapply the filter when you have made changes in the project
schedule.
 
6. To remove the filter, click on the Clear Filter button.
 

You can customize the filtering options using the Filters dialog.
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Critical Path

Critical Path Analysis helps identify the minimum length of time needed to complete a project. When you
need to run an accelerated project, the critical path will help you identify which project steps you should
accelerate to complete the project within the available time. Select the Gantt Chart View or Multiproject
View and check the Critical path option  on the View toolbar. The critical path will be highlighted with the
red color. 

The critical path of a single project shows which tasks are most critical: the ones that add up to the
longest project duration. 

Critical Path is defined for each task individually.A task is displayed as Critical if its slack (delay
potential) does not exceed the value specified in the Document Properties, Advanced tab and this delay
would delay the entire project. 

The critical path of a multiple project shows  which projects are most critical to complete all the projects
on time.
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Share

 

Presentation 

  

Capture Slides

.

ConceptDraw PROJECT allows you to make slides for presentation. You can

create slides from any of project views.

 Make slide from the current project view according to chosen option. The slides

will appear in the pop-up Slide Preview panel.

Images: Save slides in PNG format.

MS PowerPoint: Save slides as MS PowerPoint presentation (PPTX).

ConceptDraw 

DIAGRAM: Create a Project Management diagram in ConceptDraw DIAGRAM

Open in MINDMAP: Open the current document in ConceptDraw MINDMAP ,

having closed it in ConceptDraw PROJECT.

Exports

 

Adobe PDF: Export the document to Adobe PDF.

MS Excel: Options for Export project tables, as they appear in View mode, to a

Microsoft Excel workbook (XLSX).

MS Project: Export the document to Microsoft Project XML.

Mindjet MaindManager: Save the document in Mindjet MindManager  format

(MMAP).

Text Outline: Export the document to text outline.
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DIAGRAM

Project management diagrams give you the ability to view at a detailed level project attributes such as
project scope, logical connections in the project, critical paths, key events on the timeline, milestones,
tasks, calendars for work, and resource utilization. Transforming project data into different visual forms is
a productive way of looking at your project from different perspectives. It also helps you deliver project
information in suitable way depending on your objectives and audience. 

Select the proper diagram type from the drop-down list of the DIAGRAM button  on the Share tab.  There
are 10 types of visual project diagrams available: Gantt Chart, Milestones chart, PERT chart, Radial
Structure chart, Resource Calendar, Resource Usage diagram ,Timeline, Timeline From Marked Tasks ,
and WBS chart. The diagram will be generated and opened in ConceptDraw DIAGRAM.
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MINDMAP

The compatibility between ConceptDraw products allows you to migrate your documents from MINDMAP

to PROJECT and vise versa. You can see the project data in a mind map structure by opening your

project in ConceptDraw MINDMAP. Mind map will consist from topics of Project Management type,

which contain all project information. Project Notes will be opened as Notes to topics. All hyperlinks will

be displayed in the Hypernote panel.This way you are switching views without creating extra files. You

can see the same file in both applications:

ConceptDraw PROJECT
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ConceptDraw MINDMAP
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MS Excel

The drop-down list of export to MS Excel options contains two items:
1. Export tables from all views (also available from the File menu)
In this case, the Excel file will contain all the tables from the project file. The same function is available in
the Export section of the File menu under the Export to MS Excel item.

2. Export table from the current view
In this case, the Excel file will contain a single table - the last one opened before going to the Share tab.
For example, to export the Resources Usage table to MS Excel, the following steps are required: 
1. Open Resource usage view.
2. Go to the Share tab and select item 2 from the drop-down menu.
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Dialogs

Dialogs are the main means of communication between the program and the user. They are used to set
various components and properties of the program. Modal dialogs are mostly called from the menus, or
by using the keyboard shortcuts. When this dialog is open, you can't work with other  tools.

Timescale
Column Customization
Edit Markers
Predecessors
Filters
Options
Document Properties
Find
Replace
 
 



Dialogs

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

42

Timescale  

Timescale

The Timescale dialog is called  from the Timescale group of the View ribbon.
Use it to determine the time measure units   for tasks in your document.

 

 Units - Specify units from units list for large and small scales on Timescale gauge.
Align - Specify text alignment on timescale.
Count - Specify  units interval.
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Column Customization

All project views: Multiproject, Gantt, Resources, and Resource Usage contain information lists divided
into columns. The Column Customization dialogs allow the management of the columns' visibility. The
dialogs can be invoked from the context menu of the grid of each view. Also Customize Columns dialog
also can be accessed from View tab.

The most massive is the column customization possibilities of the Gantt Chart. View and edit
information to be displayed at the  project outline.

The Column Customization dialog  contains the following columns:
 

Gantt Chart View

Baseline Cost Total planned cost for an task

Baseline Finish The planned completion date for a task.

Baseline Start The planned beginning date for a task.

Complete
The current status of task in percentages of the task’s
duration that has been completed.

Cost The total scheduled cost for a task



Dialogs

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

44

Column Customization 

Cost to Completion
The piece of total scheduled cost that remains for a task
completion.

Cost1
The custom column, user can use to enter any additional
information on the task cost

CP Tasks, marked in this column make a project's critical path.

Custom Mark
Indicates tasks marked to be used in the Timeline from
Marked Tasks report.

Custom 1-10
Additional specific information important for a particular
project added by user.

Deadline
The target data, indicates when the task should be
completed

Duration The total span of a working time for a task

Early Finish The earliest date that a task could possibly be completed.

Early Slack The duration between the Early Start and Early Finish Dates

Early Start The earliest date that a task could possibly begin.

Finish The date when a task is scheduled to be completed

Hyperlinks Add/Edit hyperlinks to a task

Late Finish
The latest date that a task can finish without delaying the
finish of the project.

Late Slack The duration between the Late Start and Late FinishDates

Late Start
The latest date that a task can start without delaying the
finish of the project.

Name Project task name
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Notes Comment you can enter about the current project

Outline Level Displays the place of task in the project outline hierarchy.

Outline Number
The number that displays the associated task’s position in
the project outline hierarchy.

Planned Complete
The planned task completion status (percentages)  at the
current date.

Predecessors
The tasks numbers (#) on which the task depends before it
can be started or finished.

Priority The level of importance given to a task by project manager

Resources Resources assigned to task

Start The date when a task is scheduled to be started

Successors
The tasks numbers (#) that act as successors for the current
task (tasks, whose start or finish date is driven by their
predecessor task.)

Work
The total amount of time , scheduled on a task for all
assigned resources., or the total amount of time , scheduled
for  particular resource on a task (Assign Resource panel)

Unique ID
The Unique ID field contains the number that ConceptDraw
PROJECT automatically designates whenever a new task is
created in the current project.

Multiproject View

Baseline Cost Total planned cost for a project

Baseline Finish The planned completion date for a project

Baseline Start The planned beginning date for a project.

Budget The budget, allocated to a project.
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Company Company Name

Complete
The current status of project  in percentages of the project’s
duration that has been completed.

Complete Increase
Changing of the  Complete  value between the current  and
previously saved measured in percent

Complete Increase Rate
Changing of the Complete Increase value between the
current  and previously saved  measured in percent

Cost The total scheduled cost for a project

Cost to Completion
The piece of total scheduled cost that remains for a project
completion

Duration The total span of a working time for a task

Finish Date The date when a project is scheduled to be completed

Hyperlinks Add/Edit hyperlinks to a project

Objective Project objectives

Planned Complete
The planned project completion status (percentages)  at the
current date.

Priority The level of importance given to a project by project manager

Project Description Short description of the project

Project Manager Who is project Manager?

Project Name Project name

Project Site Url of the corresponding website
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Start Date The date when a project is scheduled to be started

Resources View

Cost

For Work resource displays the cost that accrues every time
unit, the resource is used.
For a non-human resource displays the cost that accrues at
one unit of the resource usage.

Email Contact email address assigned to resource

Group A customizable field to structure resources into groups

Hyperlinks Add/Edit hyperlinks to a resource

Name Resource name

Notes Comment you can enter about the current resource

Type
Type of the resource (work, material, cost, equipment,
company)

Unique ID
The Unique ID field contains the number that ConceptDraw
PROJECT automatically designates whenever a new
resource is created in the current project.
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Edit Markers

Mark selected item with color. Using color markers  is an efficient way to highlight rows on the project
timeline and help you position and arrange the project items.
The Edit Markers dialog is called  from the Markers group of the Home ribbon. 

Use the Edit markers dialog to set  names for Markers. Just click a marker and start typing.
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Predecessors

Predecessors dialog can be accessed from the Link section in the Home tab. The Predecessors
settings also available in the Links panel

 
Once you have created a list of project tasks, you  need to edit your project schedule in more detail by
moving tasks, setting dependences between project tasks, or making other changes using the Home tab
tools. For example: you have  tasks that you would like to link together. But, also you need to add lag
time between 2 tasks.
You can make this  using the Predecessors dialog.
 



Dialogs

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

50

Filters  

Filters

Those who use ConceptDraw PROJECT in their daily work may have faced the need to filter their project

in some special way to get the appropriate information.  To customize filtering options use the Filters

dialog that can be accessed from Edit Filter button in the Filters section on the  View tab.

In the left part of the window, you can specify the project view, which is filtered by default. There is also

the filters list which contains predefined and user created filtering options.

Filters for: Specify the project view, which is filtered by default: Project, Tasks, or Resources.
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Available Filters List: The filters list which contains predefined and custom filters.

  

 Add Filter: Add new custom filtering conditions. Edit custom filter using editing window. and  

 Add/Remove criteria buttons.

 Remove Filter: Remove the selected filters.

*The  predefined filtering options cannot be edited or removed.

Duplicate Filter: Duplicate the selected filters. If you need to modify predefined filter, you should

duplicate this filter by clicking “Duplicate filter”
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 Export Filter to File: This operation allows exporting selected custom filters into single XML file

and copying it to other computer.

 Import Filter from File: This operation allows importing your custom filters from XML file.  Thus, 

the  filters will be available on  any computer no matter which ConceptDraw PROJECT document you

work with.
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Options

Can be accessed from the File tab. Allows to configure the default application settings that will be

applied to all new documents created in ConceptDraw PROJECT.

 General

Display on a new document: Set up document default
view
Color scheme: Set up document color scheme
New document view settings: Set up new document 
view (custom or default)
Currency symbol: Set up currency symbol
Currency position: Select currency position
Decimal digits: Set up amount of decimal digits
Behaviour: On/Off the Smart Enter mode

On/Off the deadline Mircoreports automatic
generation

 
Schedule

Calendars:
Working week days: Set up working week days.
Default working time: Set up default schedule. Schedule
is presented as set of daily working time intervals.

Work units:  
Week starts on: Select  week start.
Hours per day: Set up working hours amount  per day.
Hours per week: Set up working hours amount  per
week.
Day per month: Set up working days amount  per month.

Scheduling: 
Default task type: Choose what you would like to fix:
Units, Duration or Work
Default task duration: Set up a  task duration on default
Default task start date : Set up a default start date of the
new task
Effort - driven check box: Set up the effort-driven options
for the new tasks 
Read more how to use the Effort-Driven Scheduling
Method

https://www.conceptdraw.com/helpdesk/how-to-use-the-effort-driven-scheduling
https://www.conceptdraw.com/helpdesk/how-to-use-the-effort-driven-scheduling
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 Autosave

Autosave: 
Switch on/of autosave
Every: 
Set up autosave periodicity
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Document Properties

View and Edit parameters of the current document. Document Properties dialog is available from the File
ribbon. It contains three tabs: General, Calendar and Advanced.

General 
 General tab allows  to set the starting points of project calculations. 
1. Currency section. Here you can define the project currency options.
2. Work units section. Here you can set the units of measurement for calculating the costs of

employees engaged in the project.
3. Fiscal year section. Here you can change  a fiscal year beginning date. This date affects the position

of quarters/half-years/years on the timeline and the choice of reporting period.
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Document Properties 

 
Calendar
Calendar tab is used to customize the default project calendar. To make your new calendar available for
other projects to use, save the project as a template using the Save as option in the File menu.  So the
new calendar will be there for every new project created with that template. 
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You can set up schedule for particular resources in your project.
Select resource from the drop-down list to create a Work resource personal schedule. Selects set of
dates to  do this. Set up schedule to selected dates. Schedule is presented as set of daily working time
intervals. You can set the selected dates as non-working.
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Access 
You can protect your document from unwanted access by setting a password and role-based access to
the project file. Role-based access control helps you manage who has access to project files, what they
can do, and what project information they can access. The "Protect Document Access" check box
allows you to toggle document protection mode on/off.
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To set up role-based access to a project document, follow these steps:

1. Check the box.
2. Enter the username and password. The first user gets the Project Manager role by default.
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3. Add other users by specifying their roles:

Project manager (PM) - full access to all changes in the document. You can add several PM users.
Resource manager (RM) - access only to changes in the Resource view, Resource usage, and task
assignments.
Viewer (V) - read-only access without the right to save the document.

Project Manager  user can manage access of all users
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Document Properties 

To access a protected document, one need to enter  username and password.
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Advanced
Advanced tab allows to set the critical path and critical task parameters.
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Find

This dialog allows you to search for  text in a project schedule. You can call the dialog from the Home
tab.
  

The Find dialog:
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Replace

This dialog allows you to  replace text in a project schedule. You can call the dialog from the Home tab.

The Replace dialog:
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Floating Panels

Some tools and features in ConceptDraw PROJECT are accessible from the floating panels.  Floating
panels can be accessed from the drop down list of the Panels button on the View tab.

                                                                                                                                                                                                         

                                                                                                                                                                                                         

                                        

Task
Project
Resource
Assign Resources
Solutions
Slide Navigator
Hypernote
Links
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Task

Task dialog can be accessed from Panels button  on the View tab.

Task dialog defines the project parameters and allows you to manage a task information from the Gantt

chart,

Name: Set up task name.
Duration: Set up task duration.
Measuring unit: Specify duration measuring unit.
Complete: Set up percentage of completeness.
Milestone: Convert task to milestone.
Priority: Set up task priority.
Marker: Specify task marker from list.
Baseline: Display task baseline cost.
Actual: Display task actual cost.
Start: Set up start date.
Finish: Set up finish date.
Deadline: Set up deadline date.
Scheduling: Set the Fixed Task Type
Effort driven: On/Off the Effort-Driven scheduling.
Task types: You can Split a task, or create a Recurring task.

 The three Task Types used in ConceptDraw PROJECT  are Fixed Units, Fixed Work, and Fixed

Duration. Fixed Units is set as default.

Each of the task types affects scheduling when you edit one of the three elements as follows.

Task type Units is edited Duration is edited Work is edited

Fixed Units Duration is recalculated Work is recalculated Duration is recalculated

Fixed Work Duration is recalculated Units are recalculated Duration is recalculated

Fixed Duration Work is recalculated Work is recalculated Units are recalculated
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Effort - Driven Task

Effort-driven scheduling is the default scheduling method used in ConceptDraw PROJECT . The duration
of a task shortens or lengthens as resources were added or removed from a task, while the amount of
effort necessary to complete a task remains unchanged. Effort-driven scheduling only takes effect when
resources are added to or removed from a task.
Effort-driven calculation rules are not applied when you change work, duration, and unit values for
resources already assigned to a task.

When working with effort-driven scheduling, keep the following in mind:
· The effort-driven calculations apply only after the first resources are initially assigned to the task. 

· After the first resources are assigned, the work value doesn't change as new resources are assigned

to or removed from the same task.

· If the assigned task type is Fixed Units, assigning additional resources shortens the duration of the

task;

· If the assigned task type is Fixed Duration, assigning additional resources decreases the individual

unit values for resources;

· If the assigned task type is Fixed Work, assigning additional resources shortens the duration of the

task.
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Split a Task

When you need to interrupt work on a task, you can split the task so that part of it starts later in the

schedule. You can split a task into as many sections as you need.
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Recurring Tasks

If you have a task that occurs repeatedly during the course of a project, ConceptDraw PROJECT can

help you create it as a recurring task, so you only have to set it up once.
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Project

Project dialog can be accessed from Panels button  on the View tab.

Project dialog defines the project parameters and allows you to manage a project information from the

Gantt chart and the Multiproject View

 

 

Name - Set up project name

Start Date - Display project start day

Finish Date - Display project finish day

Duration - Display project duration. Select the duration
units using the drop-down list.

Budget - Set up project budget

Company - Set up Company name

PM - Set up project manager

Site - Set up project web-site

Objective - Set up project objective

Priority - Specify project priority

Marker - Specify project marker from list
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Resource

Resource dialog can be accessed from Panels button  on the View tab.

Resource dialog defines  parameters of the project resources and allows you to manage a resource

information in the Resources list,

 

 
 
 

Name - Set up resource name.
Type - Specify one of the following  resource
type: Work,; Material; Cost; Equipment or
Company.
.
Cost - Set up resource cost. Work resources are
those with a cost over time. Other types of
resources have a fixed cost per unit

Group - Set up resource group. The resource
can participate in several groups

E-mail - Set up resource e-mail

Marker - Specify resource marker from list
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Assign Resources

Assign Resources dialog can be accessed from Panels button  on the View tab.
Use Assign Resources dialog to assign resources to project tasks,
Open Gantt Chart View and select a task to assign resources.
Select a particular resource from the resources listed at the Assign Resources panel and assign it to a
task by double clicking or pressing the Enter key.
You can even create a new resource using buttons. The new resource will be added to both the Assign
Resource dialog and the Resources list.
The Work resource you have assigned is displayed as 100% implementation. The other type resource  is
displayed as 1 unit implementation.You can change this  allocation manually after the resource has been
assigned.
Using the Effort Driven scheduling, when you assign or remove people from a task,  the duration of the
task will be the  lengthened or shortened based on the number of resources assigned to it.

 

Resource - Displays the resource name.
 
Units - Resource utilization for the current task.
 
Work - Man-hours for the Work type resource.

Add Work resource - Add new human resource
into resource pool

Add Material resource - Add new material
resource into resource pool.

 Move to Resources view - Switch to
Resources view

Calendar - Set the specific calendar for Work
type resource
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Solutions

Solution panel contains a list of project management solutions located in Solution Park. It provides
access to the number of project schedule examples, various types of reports and live graphical project
dashboards. Open the example project file to modify it, or generate a tabular, visual and mind map

reports on your project. Access the panel from the button  in the  Home tab, or using the Panels list
in the View tab.

1. Search window.  You can search for the required reports and examples. Enter the keyword in the
search field. The corresponding solutions will be displayed in the panel.

2. Search in ConceptDraw STORE. You can run the ConceptDraw STORE application to search for
the the proper solution in Solution Park 
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3. Solution section. This section contains the list  of available solutions in alphabetical order. 
The following options are available here:
a) Use the drop-down button to preview Examples and  Reports contained in the certain solution. You

can open them by click.
b) Click to download and install a free, or previously purchased solution using  the ConceptDraw

STORE application.
c) Check, to view just solutions that are already installed.
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Tabular Reports

Tabular reports in ConceptDraw PROJECT  are generated as electronic spreadsheets in MS Excell
format (XLSX). This ability is convenient for your own use and for easily sharing the reports with
stakeholders, even if they don’t have ConceptDraw PROJECT installed. There are more than pre-
designed 30 tabular reports in ConceptDraw PROJECT. Reports are combined into 7 case-oriented
solutions with many kinds of reports. Along with pre-designed tabular reports, ConceptDraw PROJECT
users can create custom reports based on a self-designed Excel template.
The group of pre-designed Table Reports  includes the following types of reports:

1. Basic Projects:
· All Task Statuses – report the table of all tasks statuses for each project;

· Milestones – report the table of milestones for each project;
· Send Task List  – report the table of tasks for each project;
· Task and Notes – report the table of tasks with start and finish dates and Text Notes.

2. Cash Flow Reports:

· Cash Flow on Projects – report the table of daily expenses per project during one month;
· Cash Flow on Resources – report the table of daily labor expenses per employee during one

month;
· Cash Flow on Tasks – report the table of daily expenses per task during one month.

3. Current Activities Reports:

· Completed Tasks – report the table of completed tasks for each project;
· Critical Tasks – report the table of critical tasks for each project;
· Overdue Tasks – report the table of overdue tasks for each project;
· Tasks in Progress – report the table of tasks in progress with task information for each

project;
· Unstarted Tasks – report the table of unstarted tasks with task information for each project.

4. Knowledge Reports:

· Knowledge Schedule – report the table of all hyperlinks with dates and associated tasks; 
· Project Knowledge – report the table of all project hyperlinks;
· Resource Knowledge – report the table of all resources hyperlinks.

5. Overview Reports:

· Anonymous Project Overview – report the table of time, costs, tasks and resources overview
without Resource names;

· Multiproject Overview – report the table of time, costs, tasks and resources overview for each
project.

6. PM Planning:

· All Tasks All Columns List – report the table of entire project schedule including hidden
columns; 

· All Visible Columns – report the table of project schedule excluding hidden columns; 
· Milestones with Notes and Objectives – report the table of milestones with notes and objectives

for each project;
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· Multiproject Goals – report the table of projects objectives for each project;
· Multiproject Managers – report the table of projects managers for each project;
· Project Team – report the table of project employee including hyperlinks;
· Resource Report – report the table of all kinds projects resources for each project;
· Top Level Tasks – report the table of project top level phases and tasks with task information

for each project.

7. Resource Usage Reports:

· List of Materials – report the mind map of used materials for each project;
· Materials Utilization – report the table of material resources utilization by tasks;
· Over Allocated Resources Details – report the table of overallocation periods with task

assignments for each employee;
· Over Allocated Resources – report the table of workloads per tasks for each employee;
· Resource Report – report the table of all kinds projects resources for each project;
· Resource Usage  – report the table of resource usage details for the current week;
· Resource Usage Summary – report the table of workload periods with costs per employee;
· Who Does What Details – report the table of tasks with statuses per employees for each

project for the current week;
· Who Does What Loading Percent – report the table of employees loading in % during the

period for each project;
· Who Does What Loading – report the table of employees loading during the period for each

project;
· Who Does What When – report the table of daily tasks assignments of employees during

current week for each project;
· Who Does What – report the table of employees workloads by tasks in current month for each

project.
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Follow the steps below to make the tabular report on your project:
1. On the Solutions panel find out the suitable report from the list above.

2. Click the report icon to view its preview on the right panel.  

3. Specify the report parameters using the Report Parameters panel.
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4. Press Generate to create the report.

5. The report will be generated and opened in MS Excel.
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Custom Repots

ConceptDraw PROJECT allows you to create a tabular project report based on a custom Excel template.
Using the  Report Wizard you can generate a custom project status report based on the ConceptDraw
PROJECT file data. Use an Excel document to create a report template. With the help of customizable
macros place the necessary data in the required cells. 
Follow the steps below to make the tabular report on your project:

1. Install the Custom Report Solution via ConceptDraw STORE. Find it in the Project
Management category on the Solutions tab.

2. Find out Custom Reports in the Solutions panel.

3. Click the report icon to view its preview on the right panel.  

1. Specify the report parameters using the Report Parameters panel.

2. Press Generate to create the report.

3. The report will be generated and opened in MS Excel.
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The Custom Reports solution includes the installation of an add-on for MS Excel. The CDProject menu
item will appear on the MS Excel toolbar after the successful installation of the solution.
The Report Wizard supplied with add-on allows you to build custom templates for various project reports
based on the ConceptDraw PROJECT file data. 

How it works
1. Use an Excel blank Workbook to create a report template. With the help of customizable macros,
place the necessary data in the required cells. 
2. In each line of the Template Sheet, the Report Wizard searches and processes certain macros. For
example:
CDPRJ_PROJECT_NAME () - displays the name of the Project.
CDPRJ_TASK_DURATION () - displays the duration of the Task.
CDPRJ_RESOURCE_TYPE () - displays the type of the resource.
CDPRJ_TASK_NAME ([PH]) - displays only Phases.
CDPRJ_TASK_NAME ([T]) - displays only Tasks
CDPRJ_TASK_NAME ([М ]) - displays only Milestones
3. Filters by certain conditions can be used as parameters. For example:
CDPRJ_TASK_NAME (## = '' Task1 '') - displays the name of the task if this name is "Task1".
CDPRJ_TASK_DURATION ("##> 5 & ## <10") - displays the duration of tasks from 5 to 10 units.
4. Use the saved Excel Template to start generating a report from the Report section in the Solutions
panel.
5. The Report Wizard loads the Excel Workbook with the report template and creates a new Workbook.
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Mind Map Reports

The mind map reports in ConceptDraw PROJECT  are generated as ConceptDraw MINDMAP files
(CDMZ). You can generate the report mind map with the help of compatibility between PROJECT and
MINDMAP.

1. Find out MINDMAP reports in the Solutions panel. 

2. Click the report icon to view its preview on the right panel.

  
3. Specify the report parameters using the Report Parameters panel.
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4. Press Generate to create the report.

5. The report will be generated and opened in ConceptDraw MINDMAP
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Visual Reports

Conceptdraw PROJECT has several types of visual reports that can help assess visually the difference
between planned and actual project data. Conceptdraw PROJECT provides user with the possibility to
track how the project is going. Project Manager can compare the actual data with the planned and
assess possible measures to resolve issues. The main tool for effective monitoring of the project
implementation is the ability to save project Baseline. It includes the value of Baseline Start, Baseline
Finish and Baseline Cost. All these indicators can operate effectively only in one case - if the project
manager, constantly receives information about the actual data compared with planned. 

Conceptdraw PROJECT has several types of visual reports that can help to assess visually the difference
between planned and actual project data. The visual reports in ConceptDraw PROJECT  are generated as
ConceptDraw DIAGRAM files (CDDZ).

1. On the Solutions panel find out the suitable visual report. 

2. Click the report icon to view its preview on the right panel.
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3. Press Generate to create the report.

4. The report will be generated and opened in ConceptDraw DIAGRAM
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Dashboards

ConceptDraw PROJECT provides the possibility of creating visual project dashboards. The PM
Dashboards solution allows generating accurate, timely, and professional looking Project Dashboard,
Radar Chart  and Tactical Dashboard. Project Dashboards are the helpful tool for  tracking project
progress and catching critical points. The ConceptDraw PROJECT’s dashboards are opened as
ConceptDraw DIAGRAM documents (CDDZ). 

1. Find out the PM Dashboard solution in Solutions panel and select the dashboard type you need to

create.

2. Click the certain dashboard icon to view its preview on the right panel.

 

3. Press Generate to create the dashboard.

4.  Project Dashboard, Radar Chart  and Tactical Dashboard will be generated and opened in
ConceptDraw DIAGRAM.
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Project Dashboard

The ConceptDraw PROJECT’s dashboard displays the current status of your project and shows where
you need to direct your management efforts.  A Project Dashboard diagram is generated from your
project data and will be opened in ConceptDraw DIAGRAM.
Project Dashboard is divided into several parts, each of them provides an overview of the project status.
In other words Project Dashboard contains a summary of project information - general information about
project, Tasks Completion, Resource and Tasks indicator, Project Complete indicator, Cost and Budget,
Resource Allocation, and Earned Value Schedule Indicators.

1. The block of general information  contains the data about name of Project Manager, goal, project’s
start and finish dates, completing status and budget.
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2. Tasks block provides the information about tasks completing. The indicators have a common color
notation: red denotes late tasks, yellow shows a normal status (on time tasks), and green indicates
tasks that are ahead of schedule (early tasks). Some indicators have links to additional graphical
reports, double-click the link to open the corresponding diagram with all additional information in full
screen mode. The list of tasks will be displayed with detailed information regarding their planned and
actual level of completion, and assigned resources.

3. Resource and Tasks section  allows to see all information about project’s work resources. Resources
are divided on groups on this pie chart, the color indicates if the group of resources is late (red color),
ahead (green color), or in time (yellow color). The quantity of resources which contains each group is
indicated in percents and by number on each sector. You can also view the degree of late or ahead of
resources groups - the yellow sector is always on the circle’s border, green sector exceeds the circle’s
border, and red sector tends to the center, the degree of remoteness from the border to one side or
another is a degree of late or ahead. 
This information is particularly useful for small projects, because for them the contribution of each
participant is greatly and valuable, and it’s important that each work regularly and in time. Resource and
Tasks indicator for large projects allows to see immediately the red sector and resources that are much
late. Click the Resource rate link to receive the detailed information for each work resource of project:
which quantity of tasks it executes and what are their statuses.
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4. Project Complete indicator  has three points you have to pay attention to color, current completion and
planned completion. Progress bar shows current project completion, below you can see the completing
status in percentage. Arrow shows planned project completion. You can click to get the additional
information about late tasks in progress  and not started tasks, the additional diagrams will be opened on
the separated pages.

5. Cost and Budget Indicator shows at the right the allocated project budget, and progress bar shows its
actual cost. The color indicates whether the project execution is within budget or, in other words, it does
not exceed the project actual cost of allocated budget. You can click to get the additional information
about 25 most expensive tasks and over-costed tasks.

6. Resource Allocation section allows to visually see what resources are over-allocated, under-allocated,
and with normal status. Over-allocation is the result of assigning more tasks to a resource than the
resource can accomplish in the working time available, under-allocation is assigning a resource to work
fewer hours than the resource has available. This information is represented in the form of colored bars,
and in percentage with information about quantity of persons at the brackets.

7. Earned Value Schedule Indicators [10] is a set of calculated project indicators:

· ACWP (Actual Cost of Work Performed) - is calculated as the sum of the products of actual
costs of the task on the task complete for all tasks.

· BCWP (Budgeted Cost of Work Performed) - is calculated as the sum of the products of
baseline costs of the task on the task complete for all tasks.

· BCWS (Budgeted Cost of Work Scheduled) - is calculated as the sum of the products of
baseline costs of the task on the planned task complete for all tasks.

· SV=BCWP-BCWS
·
· CV=BCWP-ACWP
·
·
·
·

baseline costs of all tasks.
· VAC= BAC-EAC
· TCPI=(BAC-BCWP)/(BAC-ACWP)
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Radar Chart

Radar Chart visually shows the degree of project completion. Each axis on the diagram corresponds to
one chain of linked milestones, and the number of marks on the axis corresponds to the number of
millstones.

Purple polygon includes all milestones of all chains, the blue polygon includes the completed of them.
The ratio of the areas of these polygons displays a degree of project completion.
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Tactical Dashboard

Tactical Dashboard allows to evaluate the progress of the project for some indexes and to compare it
with an expected progress. There are compared the current indexes for an unfinished project on the
tactical dashboard. So, it helps you make the tactical decisions.

 A Tactical Dashboard diagram is generated from  multiple project data and will appear in ConceptDraw
DIAGRAM. There are compared the main values: Cost, Work, Date and Work Resource Cost. The
Complete of the project is taken as a measure of comparison.
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Tactical dashboard represents four positive quadrants of Cartesian coordinate system. The projects are
displayed as circles on the plane in this coordinate system. Each of the diagrams reflects four indexes:

· X axis is a project Complete;
· Y axis is a relative estimated completion of project by any index that is calculated as quotient of

the current value and the total value;
· Diameter of the circle is an absolute estimated completion by any index that is calculated as a

difference of the current value and the total value;
· Color of the circle is a comparison of the relative estimated completion and project Complete:

green reflects the ahead, red - the lag, and yellow - in time.

Note that diameters of all circles in the same coordinate system are standardized to the biggest that is
taken as 100. A relative estimated completion is depicted reversed. The sign of project progress: the
circles go down, the color is yellow or green, the diameters decrease.

Let’s see in details each of four diagrams represented on the Tactical

1. Diagram with an estimate by the actual cost (“Actual cost / Total cost”).
There are compared Actual cost and Total cost on this diagram. Actual cost is a sum of actual costs of
all tasks of the project that are multiplied on their Complete. Total cost is a sum of actual costs of all
tasks of the project.
2. Diagram with an estimate by the actual man-hour (“Actual man-hour / Total man-hour”).
There are compared Actual man-hour and Total man-hour on this diagram. Actual man-hour is a sum of
Work values of all tasks of the project that are multiplied on their Complete. Total man-hour is a sum of
Work values of all tasks of the project.
3. Diagram with an estimate by the actual time (“Actual time / Total time”).
There are compared Actual time and Total time on this diagram. Actual time is a period between more
earlier date from project finish or current date, and project start date (Actual time=min (Finish date,
Current date) - Start date).
Total time is a project duration, is calculated as difference between project finish and start dates (Total
time=Finish date - Start date).
4. Diagram with an estimate by the actual cost of human resources (“Actual cost human resources /
Total cost human resources”).
There are compared Actual cost human resources and Total cost human resources on this diagram.
Actual cost is a sum of Costs for all resource’s tasks that are multiplied on their Complete with Work
type in the project. Total cost human resources is a sum of Costs for all resource’s tasks with Work type
in the project.
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Slide Navigator

You can create a presentation slides from a project file using  the Capture Slides button on the
Share tab. Slides will appear in the pop-up Slide Preview panel.
Slide Preview panel can be accessed from Panels button on the View tab. 
 

 
You can manage the slides in the Slide Preview panel using the context menu.

Capture Slide - Capture slide from a visible area of  the current
project view
Delete Slide(s) - Delete the selected slides
Save as PNG - Export to PNG according to chosen option

 
 Create Presentation from - Export to PowerPoint Presentation
according to chosen options 
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Hypernote

Hypernote panel can be accessed from Panels button  on the View tab. 

Notes - Notes section allows adding text Notes to project tasks, scheduled at the the Gantt chart View.

You can edit text Notes both from the Notes panel and the Notes column on the project grid. To display

the Notes column on the grid,

use the Column Customization dialog.

Hyperlinks - You can add several files hyperlinked to one task in your project file. You can add

hyperlinks to documents or Web pages. Hyperlinks can also jump to tasks, resources or projects within

your project file. The number of hyperlinks, you can add to each project item is unlimited.

hyperlink to URL;
hyperlink to document;
hyperlink to folder;
hyperlink to email address;
hyperlink to other item in the current project file;

You can add a hyperlink by clicking the Hyperlink icon  in the Gantt view grid. 
To display the Hyperlink column on the grid,use the Column Customization dialog.

 Any item with a hyperlink will be marked with icon: 

An item that has multiple hyperlinks will display this icon: 
This panel brought together the functions of adding text notes and multiple hyperlinks. The earlier

versions of ConceptDraw PROJECT had two different panels for these functionalities.
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Links

Links panel can be accessed from Panels button  on the View tab. It shows tasks linked with

selected task. Once you have created a list of project tasks, you  need to edit your project schedule in

more detail by moving tasks, setting dependence between project tasks, or making other changes using

the Links panel tools. For example: you have  tasks that you would like to link together. But, also you

need to add lag time between selected  task and the preceding task on which it depends. You can make

this also using the Predecessors dialog.

If you need to set a time lag between selected task and  the subsequent one, you have to use the

Successors tab.
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Keyboard Shortcuts and Mouse Actions

 

Keyboard Operation

ConceptDraw OFFICE Tools

Ctrl + Shift + M Create ConceptDraw MINDMAP file

Documents and Windows

Ctrl + N Create a New Document

Ctrl + O Open a Document

Ctrl + S Save the active document

Ctrl + Shift + S Save the active document under a new file name

Ctrl + P Print Preview

Ctrl + Alt + P Print the active document

Ctrl + F Activate the Quick Find tool

Ctrl + Shift + F Open the Find dialog

Ctrl + H Open the Replace dialog

Ctrl + F4 Close the active document

Ctrl + W

Ctrl + Tab Activate the next window

Ctrl + PageUp, Ctrl +

PageDown

Activate the next project in Gantt Chart View

Alt + F4 Quit ConceptDraw PROJECT
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Presentation

Ctrl + Shift + C Capture Slide (Visible area)

Application

F1 Call Help System

Alt + P Preferences (Application settings)

Ctrl + F1 Call ConceptDraw PROJECT About Dialog

Tasks

Insert Insert new task

Ctrl + Enter Add new subtask

Shift + Enter Insert new task after selected

Alt + Enter Add task to end of current level

Delete Delete selected task(s)

Ctrl + M Mark task as milestone

Ctrl + B Create deadline for a task

Ctrl + Right Indent task

Ctrl + Left Outdent task

Ctrl + Down Move item to the next position (one line down)

Ctrl + Up Move item tone line up

Shift + Left Collapse selected phase
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Shift + Right Expand selected phase

Ctrl + L Link selected tasks

Ctrl + Shift + L Unlink selected tasks

Ctrl + G Go to selected task

Enter Fast adding of new entities

Projects(s)

Insert New project

Ctrl + Shift + N New project

Delete Delete project

View

Tab Switch the View

Ctrl + Alt + G Switch to Gantt Chart View

Ctrl + Alt + R Switch to Resource List View

Ctrl + Alt + J Switch to Multiproject Dashboard

Ctrl + Alt + U Switch to Resource Usage View

Ctrl + R Call Reports dialog

Shift + Mouse wheel Horizontal Scroll

Click in Print Preview Change zoom level (in cycle)

Page Up Scroll up in Print Preview



Keyboard Shortcuts and Mouse Actions

ConceptDraw PROJECT  User Interface Reference © 2024 CS Odessa corp.

99
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Page Down Scroll down in Print Preview

Editing

Ctrl + Z Undo the last operation

Alt + Backspace

Ctrl + Y Redo what was reserved by Undo

Ctrl + X Cut the selection to the Document

Shift + Del

Ctrl + C Copy the selection to the Document

Ctrl + V Paste the content from the Document

Shift + Insert

Esc Close Dialog

Selecting

Select with Shift Allow to select several tasks

Select with Ctrl Allow to select several tasks (from the first to the

second)

Ctrl + A Select all the tasks on document

Esc Deselect
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